MUTE FUNCTIONS

You can use UltraMix to program mutes throughout your
mix. All mute data is recorded separately from fader-level
data. That means that any fader moves recorded before you
muted a track are still there; in fact, you can still see them
happening on-screen. If you remove the mute, the prere-
corded fader levels are still there. As in most consoles, all
UltraMix mutes are post-fader.
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NOTE: The Ultra-34 Mute toggles on rapidly (approxi-
mately 1 millisecond) and toggles off less rapidly
(approximately 50 milliseconds). The reason is that a rap-
idly opening mute (mute off) would cause audible
artifacts. To achieve very precise timing, move any mute
events forward or backward in time using the Event Editor.

& To record mutes:

1. Disable all recording modes by clicking on whichever
record mode button (Replace, Null, or Trim) is currently lit.
All three must be unlit.

EXTREMELY IMPORTANT: If you do not disable record-
ing modes, then you might discover you're recording
new fader levels as determined by current controller po-
sitions, whether or not that’s what you intended to do.

2. Enable Mute record by clicking the Mute button on
UltraMix’s control bar, or on the UltraPilot by pressing the
Shift button (right column) Soft Mode button 13 to light the
Mute LED.
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3. Place any tracks where mutes are desired into Record/
Ready mode.

4. Enable the Master Record button.

5. Roll your mix.

6. Press the Mute Soft Button on UltraPilot or click the
Mute button (the one with the “M”) on the session window.
This mutes the track. The Mute button will light on the ses-
sion window, and the LED next to the Soft Button on the
UltraPilot will light up as well.

7. Press or click again to unmute the track. The Soft Button
LED and “M” button will go off.

& To mute tracks using the computer keyboard:
1. Select the track(s) you want to mute.
2. Arm the track(s) in Record/Ready.
3. Hit the M key to mute the track(s).

4, Hit the “” (comma) key or Shift-M to unmute the
track(s).

The computer keyboard technique is an easy way to accu-
rately mute a number of tracks simultaneously, particularly
if the tracks are nonadjacent. Also, by using the computer
keyboard, you can toggle mutes between two tracks, or be-
tween one track and several other tracks. This is handy for
building comp tracks for a lead vocal, or creating dynamic
interplay between one or more instruments and several
other instruments.

& b toggle mutes:

1. Select all tracks you want to toggle between, or among. If
only two are selected, the mute will toggle between those
two. If more than two are selected, the toggling will happen
between the first track(s) muted and all remaining tracks.

2. Place all selected tracks in Record/Ready.

3. Mute the first track(s) using UltraPilot or by dragging
across the Mute buttons in the UltraMix session window.

4. Press the T button on the computer keyboard. Currently
muted track(s) will unmute, and all other selected and
armed tracks will mute.
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5. Press T again and the first track(s) will mute, while the
others will unmute. Toggling can continue indefinitely.

If you want to change your mutes, you can punch in new
ones at any time. If you want to remove a mute completely
(and it's too late to use Undo), you can do it very easily in
the Event Editor, as explained later.

THE AUTOMUTE FUNCTION

Automute is a feature (exclusive to UltraMix as of this writ-
ing) that automatically performs one of the most tedious
tasks of multitrack audio mixing: muting unused portions of
tracks. This procedure is important because unused bits of
tracks contribute to noise build-up in your final mix. This is
true even if you record using a digital recorder and virtual
MIDI tracks, because the output section of any instrument
will produce some noise.

The secret behind Automute is UltraMix’s unique level-sens-
ing capability. (That's why only UltraMix automation offers a
metering mode.) Inside each channel of the Ultra-34, a cir-
cuit detects the instantaneous input level, encodes it as
MIDI data, and sends the information back to the UltraMix
Pro software. Since UltraMix knows when a track is active
and when it isn’t, it can do your mutes for you! Here’s how
you make it happen.

TIP: It is best to avoid stopping and starting while re-
cording an Automute pass. Due to the nature of sync
Jollowing tape and external time code, hiccups (indis-
creet interruptions) are avoided when you allow for a
Jresh start.
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AUTOMUTE
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& o Automute:

1. Enable Automute by clicking the Automute button on
UltraMix’s control bar, or by pressing Shift/Soft Key 14 on
the UltraPilot.
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Note that any fader record modes are automatically dis-
abled, and VCA bypass toggles on so you can listen to your
tracks during the Automute pass. Also, the fader window
disappears. Don’t panic. This is normal, and you won't need
it anyway.

2. Place all tracks you want included in the Automute pass
in Record/Ready. In most cases, this will be all tracks. Ex-
ceptions might be tracks with a wide dynamic range or very
low-level signals, right down near the noise floor, that you
want to keep. You may have to do manual mutes with these.
However, even if you do include these low-level tracks in
your Automute pass and have problems, changing or erasing
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Automute events in the Event Editor window is rather easy.
For information on fine-tuning an Automute pass, see the
Event Editor section on page 152.

3. Enable the Master Record button.

4. Roll your mix. You will hear input signals at Unity because
VCA bypass is enabled; you will NOT hear Automute working
in real time. During this pass, Automute is scanning your in-
put levels and “taking notes.” Whenever the input level falls
below the preset threshold (see below), Automute records a
mute event. When it comes back above the threshold, that
channel is unmuted. Automute events are indicated by the
yellow bars that go on and off right under the manual Mute
button: on when muted, off when unmuted.

5. Have a cup of coffee, scan the sports page, or dream up
new harmonies for the chorus.

6. Rewind, and see if all the mutes are where you want them.

Automute works much like auto-gating, and is certainly
much less expensive than equipping each channel with a
high-quality dynamics processor. Because it doesn’t work in
real time, Automute has an advantage: it backtimes and
adds a few frames before each mute, so the “gate” opens a
fraction of a second before the leading edge of the signal.
That means you don’t get any dulling of attack transients.

If Automute is letting noise through, or if it is cutting off a
desired signal, you can adjust the threshold as follows.

& To adjust the Automute threshold:
1. Choose Preferences from the File menu.

New Session 3N
Dpen Session... #0
Close Window #W
Save Session S

Save Session As

Save As Default
Preferences

Page Setup
Print TrackSheet #P

Import Win93 Session...

Quit #0
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2. Select the Mixer icon.

3. Choose Low, Medium or Hi from the Automute Level
menu. The three settings are about 10dB apart.

Preferences
Mixer Settings

Medium,.

Auto-Save D Destructive Solo

Remember, the same setting is global for all tracks subject
to the Automute function on a given pass. If one threshold
doesn’t work for all tracks, you can do multiple passes at
different thresholds. Or you can try rerouting inputs through
the channel Line Input (rather than the Tape input) and
using the Trim control to reduce the gain of any signals that
are too “hot.” Or, patch into an unused Ultra-34 channel
from a post-fader direct out for full fader trim.

There are no hard and fast rules regarding Automute. Some
users will find it a powerful tool for cleaning up tracks, and
perhaps even for creating special mixing effects. Others may
prefer doing all mutes manually. We suggest you at least ex-
periment with it for awhile, and find out if and when you
want to include it in your mixing procedures.

SUGGESTED APPROACHES FOR BEGINNING YOUR MIX

There is no one best way to mix with UltraMix. No single
technique has yet received the Good Mixkeeping Seal of Ap-
proval, and no Holy Person of any spiritual persuasion has
blessed any one method.

After all, what’s best for you may be a total nightmare for the
folks working in a studio just down the street. And, from
your own experience, you probably know that what works for
a four-minute music track may be totally wrong for a 30-sec-
ond radio spot.
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Open And Name
A New Mix File

Set UltraMix
Levels To Unity
Gain

DO A MUTE PASS

Do A Manual
Mute Pass For
Track Segments
You Don’t Want

So the following procedures are suggested as ways to get
started. Once you've done a few mixes, you'll naturally de-
velop your own approaches.

Also, the order of procedures in the following section is not
fixed. (Well, it is for our purposes here, but...) In some
cases, you can move them around; in other cases it would
complicate matters. Let common sense be your guide.

This part is pretty self-explanatory. If you are opening your tem-
plate file, don’t forget to “Save As” and rename it immediately.

The easiest way to do this is by using either the Modify Levels
or Set Default Levels commands as already explained (page
65). The Unity fader levels should match your console levels
(toggling VCA bypass on and off has no audible effect).

Get those tracks quieted down now as described in The
Automute Function section on page 109. If you're not into
Automute, proceed to...

You could do this before you record any fader moves, but
you'd probably be making many of those decisions while
making your rough balances anyway. So dump all the stuff
you don’t want now! If you didn’t do an Automute pass, you
can mute inactive tracks manually now. If you did do an
Automute, but it missed a few things, you can try cleaning
up any little blemishes by ear.

DETERMINE YOUR DYNAMIC MIX STRATEGY

Method 1:
UltraPilot One
Bank At A Time

Now it’s time to determine your basic approach to dynamic
fader moves. And, as Click and Clack (the Tappet Brothers)
would say, you can go about it in basically three ways:
Method 1, Method B, or Method III.

With this method, you build your dynamic mix in small num-
bers of channels (less than 16). In other words, in each mix
recording pass, you make your moves in real time using

UltraPilot faders, while never switching to the other bank in
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Method B:
Simultaneous
Faders And
Mouse

Method III:
Bank Switching

that window, or to other Ultra-34 windows. This is the easi-
est and most intuitive way to go about it, and you'll probably
find it works in the vast majority of cases.

With this method, you assign your UltraPilot to the bank
wherein you will be doing most of your moves. But, if you
have one or two moves on the other bank, you can arm (put
in Record/Ready) all the tracks in both banks that you will
be recording on that pass, then use the faders to make
moves in one bank and the mouse to make moves in the
other bank.

If you really want to simulate the time-honored (non-auto-
mated) way of doing all your moves in one pass, you can do
it. But it’s tricky. Of course, the good news is that if you fluff
a move, it’s easy to go back and fix the part you fluffed.

The main thing to remember here is that you don’t want to
arm any tracks on the bank you are switching to until AF-
TER you make the switch. That’s because, when you switch
over, you could record unwanted level jumps as UltraMix
interprets the new UltraPilot controller position as a move.
Instead, you switch the bank first, line up your fader for a
move, and then hit the track Record/Ready key to punch
into record. With a little practice, you'll find you can do this
quickly, even on two or three tracks at once. The Null mode
may prove easiest to use across banks.

Rather than dealing with banking and record toggling, you
can use grouped faders across banks and windows. (See the
Grouping Faders section on page 125.)

EDITING YOUR MIX USING EDIT MENU COMMANDS

You can use the familiar Cut, Copy, Paste, and Clear com-
mands in your Edit menu to quickly make changes to your
mix. These commands can be very useful in a number of cir-
cumstances. For example, if you've worked out some tricky
moves and mutes for a vocal line and you want to patch
them into another channel for stereo, you can transfer all
your automation moves into that second fader in just a few
seconds using the Copy command.
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Intro To Edit
Functions

“Global” Fader
Editing And The
Edit Filter

In some cases, this will eliminate the need to go back and
punch in changes on another pass.

There are two basic approaches to editing faders and mute
events, either from selected faders in the fader windows (ses-
sion or group master), or from selected faders and event types
within the Event Editor. The fader window edit procedure is
more “global” in nature and applies to any selected faders for
the entire mix, inclusive of everything you have recorded on
the faders. Using the Event Editor to manipulate data allows
for concise editing of specific event types within certain time
ranges on single or multiple faders, true. But the Event Editor
has a local, small-town charm to it, too.

Editing tools such as Cut, Copy, Paste, and Clear (“c/c/p/c”)
are common functions that allow us to save a lot of time and
energy over manual mixing (one of the main reasons that
word processing on computers has replaced typewriters).
UltraMix’s edit functions allow you to hone or construct a
mix with maximum mix processing flexibility, allowing you
to flow with patching or signal-routing changes, to avoid the
“start from scratch” syndrome, and to easily come up with
some creative ideas.

UltraMix offers an additional aid called the Edit Filter,
which you'll come across when using the c¢/c/p/c tools. A dia-
log prompt will be displayed, asking you what you'd like to
edit or move on any selected fader. Each fader may contain
level, mute and Automute events, depending on what you
have recorded on various passes. This “what?” prompt is an
UltraMix power tool (not a toy) that you will come to appre-
ciate after a few mixes. Let’s start in on a few examples to
learn about UltraMix fader editing.

& To Copy events from one fader to another:

1. Select a fader that you've recorded events on (in this ex-
ample, fader 1), using the mouse or left/right arrow keys.
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2. From the Edit menu, select Copy Fader and you'll get the
following prompt:

Copy What?

Please select the events you
wish to Copy...
[<] Mutes

<] Auto-Mute
[ Levels

[ Cancel ][[ Copy ]]

In this example, if you had just changed channel 1 from
mono to stereo, using channel 2 as the second channel, you
would probably want to duplicate the fader 1 moves (with-
out having to rerecord them) by first copying them, and
then pasting them over to fader 2. You would also want to
retain the original channel 1 events as they are.

Since this Copy/Paste operation is global in nature, all of the
events for the entire track duration will be copied and
moved. The Edit Filter is the multiple-choice checkbox list-
ing that allows you to chose any or all of the level, mute or
Automutes to be used. Simply select or clear the appropriate
checkboxes and click the Copy button. Once you click the
Copy button you have succeeded in copying those “filtered”
events into the computer’s clipboard memory (but not yet
onto the other fader).

Copy What?

Please select the epents you
wish to Copy...
] Mutes

[<] Auto-Mute
[ Levels
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& To Paste events from one fader to another:

1. Select fader 2 with the mouse or arrow keys. Let’s assume
you haven't recorded any events on fader 2. If you had, it is
important to note that all previous fader 2 events would be
completely replaced(!) once the Paste action is completed.

2. Select Paste Fader from the Edit menu, click Paste, and
you've successfully copied the events from the clipboard into
fader 2.

Undo Paste Fader ®Z

Cut Fader #H
Copy Fader #C

Paste Fader
Clear Faders

Delete Time #D
Insert Blank Time #H

Add Program Change... #K
Modify Levels... #L

Set Default Levels...
Edit Program Change... #¥=

Select Al %R

You're done with this cloning exercise. If you play back the
session in the above example, fader 1 and 2 will be identical.

@ To have some extra fun (that is, to see what you just did):

1. Select both faders 1 and 2 and then choose Event Editor
from the Windows menu (88 /Ctrl-E or Windows>Event editor).

Event List Editor
€% start:[00:00:00:09] ena:[D0:00: 0 :071]

|Custom Fader Set... VI [ Add Set ] [ Rernowve Set ]

Fad 1-Ultra-34 ] Fad 1-Ultra-34
Fad 2-UThr3-34 Add Fad 2-UTtra-34

|| Fad 3-Ultra-34
i

Fad 4-Ultra-34

E Fade In E Fade Qut E Mutes E Auto-Mutes E Frograms

Fader Marne |From | To Start Time End Tirne
Fad 2 - |oo:o0:01 00 4
Fad 1 - |oo:00:01:00
Fad 1 - |oo:oo:o1 10
Fad 2 - |oo:oo:o1 10
B Fad 1 Zz | 76 |00 :00:01:10 |00 :00 02 ;00
b Fad 2 zz | 76 [o0:00:01 10 |00 00 02 ;00
Fad 1 [m]]| - [oo:o0:02:06
Fad 2 [m]]| - [oo:o0:02: 08
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If you had enabled the Level, Mute and Automute filters, the
list displays double everything: twins of each event, one per
fader. Don’t worry, it’s still safe to drive. Close the Event Edi-
tor or play around a bit — we'll be revisiting it later (see
page 152).

Another scenario: If you were unsure about the levels on a
certain fader (say fader 5) and you wanted to rerecord
them, but were uncertain enough to first back up the levels
to an unused channel (fader 31) — you could use the Cut
function. Let’s also say that you like the Automute and mute
events on fader b, and that you only want to try recording
the levels again.

& To Cut events from one fader and Paste onto another:

1. Start by selecting fader 5 with the mouse or left/right arrow
keys. Choose Cut Fader from the Edit menu (88/Ctrl-X)...

ﬂ: sez‘

Cut Fader .

Copy Fader . ®C
Paste Fader #U
Clear Faders

Delete Time #D
Insert Blank Time #H

Add Program Change... #K
Modify Levels... #L

Set Default Lerels...
Edit Program Change... #¥=

Select All #A

...And the “Cut What?” dialog is displayed.

Cut What?

Please select the events you
wish to Cut...
[<] Mutes

<] Auto-Mute
[ Levels

[ cancel || cut |
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2. Clear the Auto-Mute and mute checkboxes — leave Levels
checked — and click on the Cut button.

Cut What?

Please select the events you
wish to Cut...
[ Mutes

[] Auto-Mute
[ Levels

You have now removed the level data from the fader and placed
it in the computer clipboard. This is different than copying,
which would have left the data behind on fader 5. Cut allows for
a fresh start with no level remnants to bother you.

3. Select fader 31 and then choose Paste Fader from the
Edit menu. You now have the fader 5 Levels backed up on
fader 31. Note that this Edit Filter function did not over-
write any current mutes or Automutes on fader 31, but
replaced only the levels on fader 31, if any were present.

If you want to clear levels, mutes, or Automutes on any num-
ber of faders, use the Clear Faders command on the Edit
menu. This command is especially handy for starting from
scrateh, that is, returning a fader to having a “clean slate.”

& To Clear events from faders:

1. Select any faders you want to clear by using the mouse or
keyboard commands, then choose Clear Faders from the
Edit menu.

Clear What?
Please select the epents you
wish to Clear...
[ Mutes
[ Auto-Mute
[ Levels
[ cancel | | ciear ||
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Some Basic
Rules For Fader
Edit Functions

The “Clear what?” dialog box is displayed. Select the event
types that you want to remove from the selected faders, then
click on the Clear button or hit the Enter key.

Clear What?

Please select the events you
wish to Clear...
[<] Mutes

[< Auto-Mute
[ Levels

(concer ) (RN

¢ You can Undo any of the Cut/Copy/Paste/Clear functions.
For instance, if you Paste information into the wrong place
(oops!), immediately go to the Edit menu and select Undo
(at least before you go on to something else). Your Paste
command has been canceled. (If you had previously Cut or
Copied a fader, it will still be saved on the clipboard). Undo
is a single-step function, though, so you can only go back
one step.

Undo Clear Faders,

Cut Fader #H
Copy Fader #C
Paste Fader #®0
Clear Faders

Delete Time #D
Insert Blank Time #H

Add Program Change... #K
Modify Levels... #L

Set Default Lerels...
Edit Program Change... #=

Select All #A

¢ You can only Cut or Copy a single fader inside of a fader
window and paste it elsewhere. You can Clear multiple faders.

e C/c/p/c occurs over the duration of the track. For instance,
if you Cut or Copy a fader that contains only three minutes
of data and Paste it onto a fader that has ten minutes of
data, the three minutes (beginning to end, all inclusive) re-
places the ten minutes of data.
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